


12–2 Chapter 12: Design Space Explorer
General Description
DSE Exploration 
The DSE compares all exploration point results with the results of a base compilation, 
generated from the initial settings that you specify in the original Quartus II project 
files. As the DSE traverses all points in the exploration space, all settings not explicitly 
modified by the DSE default to the base compilation setting. For example, if an 
exploration point turns on register retiming but does not modify the register packing 
setting, the register packing setting defaults to the value you specified in the base 
compilation.

1 The DSE performs the base compilation with the settings you specified in the original 
Quartus II project. These settings are restored after the DSE traverses all points in the 
exploration space.

General Description
You can use the DSE in either the graphical user interface (GUI) or from a command 
line. To run the DSE with the GUI, either click Launch Design Space Explorer on the 
Tools menu in the Quartus II software, or type the following at the command prompt:

quartus_sh --dse r 

To run the DSE from a command line, type the following command at the command 
prompt:

quartus_sh --dse -nogui [<options>] r

You can run the DSE with the following options:

-archive
-concurrent-compiles [0..6]
-custom-file <filename>
-decision-column <"column name">
-exploration-space <"space">
-ignore-failed-base
-ignore-signalprobe
-ignore-signaltap
-llr-restructuring
-lower-priority
-lsf-queue <queue name>
-nogui
-project <project name>
-revision <revision name>
-run-power
-search-method <"method">
-seeds <seed list>
-skip-base
-slaves <"slave1, slave2, slave3......">
-stop-after-time <dd:hh:mm>
-stop-after-zero-failing-paths
-use-lsf

The DSE script is in the default Quartus II software installation in 
<Quartus II installation directory>/common/tcl/apps/dse/dse.tcl on the Windows and 
Linux platforms. 

To launch the DSE from the Quartus II software user interface, on the Tools menu, 
click Launch Design Space Explorer. 
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DSE Flow
1 For more information about the DSE, launch the DSE GUI. On the Help menu, click 
Contents or press the F1 key.

Figure 12–1 shows the DSE user interface. The Settings tab is divided into two 
sections: Project Settings and Exploration Settings.

Timing Analyzer Support
The DSE supports both the Quartus II Classic Timing Analyzer and the Quartus II 
TimeQuest Timing Analyzer. You must set the timing analyzer prior to opening the 
project in the DSE. After the timing analyzer is set, the DSE performs the design 
exploration with the selected timing analyzer that guides the Fitter.

1 TimeQuest is launched directly from the DSE if you set the default timing analyzer to 
TimeQuest.

DSE Flow
You can run the DSE at any point in the design process. However, Altera recommends 
that you run the DSE late in your design cycle when your focus is on optimizing 
performance and power. The results gained from different combinations of 
optimization options may not persist over large changes in a design.

Figure 12–1. DSE User Interface 
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DSE Support for Altera Device Families
The DSE runs the Quartus II software for every compilation specified in the 
Exploration Settings options. The DSE selectively determines the best settings for 
your design based on the Exploration Settings you have chosen. The Quartus II 
software always attempts to achieve all your timing requirements regardless of 
whether or not you are running the DSE. The Exploration Settings you choose in the 
DSE will determine the settings to be used for compilation. The DSE does not change 
the behavior of the Quartus II software.

The DSE reports the compilation that has the smallest slack. Specifying all timing 
requirements before you use the DSE to explore your design is very important to 
ensure that the DSE finds the optimal set of parameters for your design based on 
design criteria you set in your initial design.

You can change the initial placement configuration used by the Quartus II Fitter by 
varying the Fitter Seed value. You can enter seed values in the Seeds field of the DSE 
user interface.

1 To set the seed value on the Assignments menu, click Settings and select Fitter 
Settings.

Compilation time increases as the DSE exploration spaces become more 
comprehensive. Increased compilation time results from running several compilations 
and comparing the generated results with the original base compilation results.

For typical designs, varying only the seed value results in a 5% fMAX increase. For 
example, when compiling with three different seeds, one-third of the time fMAX does 
not improve over the initial compilation, one-third of the time fMAX improves by 5%, 
and one-third of the time fMAX improves by 10%.

DSE Support for Altera Device Families
The DSE support varies across Altera device families. The Stratix® series of devices, 
the Cyclone® series of devices, and Arria® GX devices can take advantage of all 
available the DSE optimization methods. The MAX® II series of devices and older 
families, such as the APEX™ series of devices and the FLEX® series of devices, support 
a subset of the DSE options.

DSE Project Settings
This section provides the following information about the DSE project settings:

■ Setting up the DSE work environment 

■ Specifying the revision

■ Setting the initial seed

■ Quartus II integrated synthesis

■ Restructuring LogicLock regions
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Setting Up the DSE Work Environment
From the DSE GUI, you can open a Quartus II project for a design exploration with 
either of the following actions:

■ On the File menu, click Open Project and browse to your project. 

■ Use the Quartus II icon to open a project.

Specifying the Revision
You can specify the revision to be explored with the Revision field in the DSE user 
interface. The Revision field is populated after the Quartus II project has been 
opened.

1 If no revisions were created in the Quartus II project, the default revision, which is the 
top-level entity, is used. For more information, refer to Managing Quartus II Projects 
chapter in volume 2 of the Quartus II Handbook.

Setting the Initial Seed
To specify the seed that the DSE uses for an exploration, specify a non-negative 
integer value in the Seed box under Project Settings on the Settings tab. The seed 
value determines your design’s initial placement in a Quartus II compilation.

To specify a range of seeds, type the low end of the range followed by a hyphen, 
followed by the high end of the range. For example, 2-5 specifies that the DSE uses the 
values 2, 3, 4, and 5 as seeds.

Restructuring LogicLock Regions 
The Allow LogicLock Region Restructuring option allows the DSE to modify 
LogicLock region properties in your design, if any exist. The DSE applies the Soft 
property to LogicLock regions to improve timing. In addition, the DSE can remove 
LogicLock regions that negatively affect the performance of the design.

1 “Exploration Space” on page 12–6 describes the type of explorations you can perform.

Search for Best Performance, Search for Best Area Options, or Search for Lowest 
Power Option
Use the Exploration Settings list to select the type of exploration to perform: Search 
for Best Performance, Search for Best Area, or Search for Lowest Power. 

The Search for Best Performance option uses a predefined exploration space that 
targets performance improvements for your design. Depending on the device that 
your design targets, you can select up to five predefined exploration spaces: Low 
(Seed Sweep), Medium (Extra Effort Space), High (Physical Synthesis Space), 
Highest (Physical Synthesis with Retiming Space), and Selective (Selected 
Performance Optimizations). As you move from Low to Highest, the number of 
options explored by the DSE increases, which causes compilation time to increase.
© November 2008 Altera Corporation Quartus II Handbook Version 8.1 Volume 2: Design Implementation and Optimization

http://www.altera.com/literature/hb/qts/qts_qii52012.pdf


12–6 Chapter 12: Design Space Explorer
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The Search for Lowest Power option uses a predefined exploration space that targets 
overall power improvements for your design. When Search for Lowest Power is 
selected, the DSE automatically runs the PowerPlay Power Analyzer for each point in 
the space. You must ensure that the PowerPlay Power Analyzer is configured 
correctly to ensure accurate results. The DSE issues a warning if the confidence level 
for any power estimate is low. 

The Search for Best Area option uses a predefined exploration space that targets 
device utilization improvements for your design.

Quartus II Integrated Synthesis
The Project Uses Quartus II Integrated Synthesis option works only for designs that 
have been synthesized with Quartus II integrated synthesis. With this option turned 
on, the DSE explores options that affect the synthesis stage of compilation.

f For more information about integrated synthesis options, refer to the Quartus II 
Integrated Synthesis chapter in volume 1 of the Quartus II Handbook.

Using the DSE to Search for the Best Performance
This section describes using the DSE to search for the best performance in your 
design.

Exploration Space
When you select Search for Best Performance under the Exploration Settings in the 
DSE GUI, you can select the effort level you wish to use to compile your design in the 
DSE. The effort levels are Low (seed sweep), Medium (Extra Effort Space), High 
(Physical Synthesis Space), Highest (Physical Synthesis with Retiming Space) and 
Selective (Selected Performance Optimizations). The DSE traverses the points in the 
exploration space, applies the settings to the design, and compares compilation 
results to determine the best settings for your design based on your chosen effort 
level. Search time increases proportionally with the breadth of the options being 
explored. The exploration space search time increases with the number, type, and 
combination of options the DSE explores.

The DSE offers the following exploration space types: 

■ “Seed Sweep”

■ “Extra Effort Spaces”

■ “Physical Synthesis Spaces”

■ “Physical Synthesis with Retiming Space”

■ “Selective Performance Optimization”

Seed Sweep
Enter the seed values in the Seeds field in the DSE user interface. There are no 
“magic” seeds. The variation between seeds is truly random, any non-negative 
integer value is as likely to produce good results. The DSE defaults to seeds 3, 5, 7, 
and 11. The Low (Seed Sweep) option exploration space does not change your netlist.
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1 The Seeds field accepts individual seed values, for example, 2, 3, 4, and 5, or seed 
ranges, for example, 2-5.

Compilation time increases 1¥ for every seed value you specify. For example, if you 
enter five seeds, the compilation time increases to 5¥ the initial compilation time.

Extra Effort Spaces
The Extra Effort Space exploration space adds the Register Packing option to the 
exploration space done by the Seed Sweep. The Extra Effort Space exploration space 
also increases the Quartus II Fitter effort during placement and routing. However, the 
Extra Effort Space exploration space does not change your netlist.

Physical Synthesis Spaces
The Physical Synthesis Space exploration space adds physical synthesis options such 
as register retiming and physical synthesis for combinational logic to the options 
included in the Extra Effort Space exploration space. These netlist optimizations 
move registers in your design. Look-up tables (LUTs) are modified by these options. 
However, the design behavior is not affected by these options.

f For more information about physical synthesis, refer to the Netlist Optimizations and 
Physical Synthesis chapter in volume 2 of the Quartus II Handbook.

The Physical Synthesis for Quartus II Integrated Synthesis Projects exploration 
space includes all the options in the Physical Synthesis exploration space and 
explores various Quartus II integrated synthesis optimization options. The Physical 
Synthesis for Quartus II Integrated Synthesis Projects exploration space works only 
for designs that have been synthesized using Quartus II integrated synthesis software. 

Physical Synthesis with Retiming Space
The Physical Synthesis with Retiming Space exploration includes all the options in 
the Physical Synthesis Space exploration space, and it explores various Quartus II 
Integrated Synthesis optimization options and register retiming. Register retiming can 
move registers in your design.

The Physical Synthesis with Retiming Space exploration works only for designs that 
have been synthesized using Quartus II Integrated Synthesis. 

Selective Performance Optimization
The Selective Performance Optimization space combines a seed sweep with various 
performance Fitter settings to improve the timing of your design. The seed sweep is 
performed over a limited number of points in such a way that the base settings are not 
replicated. This is the recommended option for large designs where other spaces may 
be too large.

Table 12–1 shows the settings adjusted by each exploration space.
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DSE Flow Options
You can control the configuration of the DSE with the following options:

■ Create a Revision from the DSE Point

■ Stop Flow When Zero Failing Paths are Achieved

■ Continue Exploration Even If Base Compilation Fails

■ Run Quartus II PowerPlay Power Analyzer During Exploration

■ Archive All Compilations

■ Stop Flow After Time

■ Ignore SignalTap and SignalProbe Settings

■ Skip Base Analysis and Compilation If Possible

Create a Revision from the DSE Point
After you have performed a design exploration with the DSE, a Quartus II revision 
can be made from any exploration point. This option facilitates the creation of 
multiple revisions based on the same space point for further optimization within the 
Quartus II software.

Stop Flow When Zero Failing Paths are Achieved
Instructs the DSE to stop exploring the space after it encounters any point, including 
the base point, that has zero failing paths. The DSE uses the failing path count 
reported in the All Failing Paths report column to make this decision.

Table 12–1. Summaries of Exploration Spaces  (Note 1)

Search Type

Exploration Spaces

Seed Sweep Extra Effort
Physical 

Synthesis  Retiming

Analysis and Synthesis Settings

Optimization technique — — v v

Perform WYSIWYG resynthesis — — v v

Perform gate-level register retiming — — — v

Fitter Settings

Fitter seed v v v v

Register packing — v v v

Increase PowerFit Fitter effort — v v v

Perform physical synthesis for 
combinational logic

— — v v

Perform register retiming — — — v

Note to Table 12–1:

(1) For exploration spaces that include Quartus II Integrated Synthesis Projects, DSE increases the synthesis effort.
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Continue Exploration Even If Base Compilation Fails
With the Continue Exploration Even If Base Compilation Fails option turned on, the 
DSE continues the exploration even when a design compilation error occurs. For 
example, if timing settings are not applied to your design, a the DSE error occurs. To 
cause the DSE to continue with the exploration instead of halting when an error 
occurs, turn on this option.

Run Quartus II PowerPlay Power Analyzer During Exploration
Turn on Run Quartus II PowerPlay Power Analyzer During Exploration to run the 
Quartus II PowerPlay Analyzer for every exploration performed by the DSE. Using 
this option can help you debug your design and determine trade-offs between power 
requirements and performance optimization.

Archive All Compilations
Turn on Archive all Compilations to create a Quartus II Archive File (.qar) for each 
compilation. These archive files are saved to the dse directory in the design’s working 
directory.

The result of each DSE run is saved as a .qar file in the dse subdirectory under your 
project directory. Each run is identified by a number. The best result of the DSE run is 
saved with the name best.qar.

The dse directory also contains a spreadsheet (results.csv) that compares the results of 
all the individual runs in your DSE compilation.

Stop Flow After Time
Turn on Stop Flow After Time to stop further exploration after a specified number of 
days, hours, and/or minutes.

1 Exploration time might exceed the specified value because the DSE does not stop in 
the middle of a compilation.

Ignore SignalTap and SignalProbe Settings
The DSE uses advanced physical synthesis options that are not compatible with the 
SignalTap® II or SignalProbe features. As a result, the DSE issues an error message 
similar to the following example when a project is opened for exploration that has 
either SignalTap II or SignalProbe turned on. 

Error Opening Project---------------------------
Project is using SignalProbe. Please turn off SignalProbe before using 
this project with Design Space Explorer or Ignore SignalProbe Setting 
in your Design on the Options menu.

When either the Ignore SignalTap Settings or the Ignore SignalProbe Settings 
options are turned on, the DSE bypasses this check. 

If you have already verified the design, you might save compilation time and improve 
resource utilization by turning this option on.
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Skip Base Analysis and Compilation If Possible
The Skip Base Analysis & Compilation if Possible option allows the DSE to skip the 
Analysis and Elaboration stage or the compilation of the base point if base point 
compilation results are available from a previous Quartus II compilation.

DSE Configuration File
Many options exist that allow you to customize the behavior of each DSE exploration. 
For example, you can specify seed values or a list of slave computers to be used for a 
distributed exploration run. Each time you close the DSE GUI it saves these values in 
a configuration file, dse.conf. The next time you launch the DSE GUI, it reads the 
values from dse.conf and restores the previous exploration settings.

Where the dse.conf file is stored varies depending on the operating system that 
launches the DSE. Table 12–2 specifies the locations where dse.conf files are stored.

1 Settings specified in the DSE command-line mode are not saved to a dse.conf 
configuration file.

Parallel DSE Information
This section covers the Parallel DSE option, which enables you to run an exploration 
on multiple computers concurrently. This feature increases the processing efficiency of 
design space exploration. You can access the settings for Parallel DSE from the 
Parallel DSE menu in the DSE GUI.

Computer Load Sharing in the DSE Using Distributed Exploration
The DSE uses cluster computing technology to decrease exploration time when you 
click Distribute Compilations to Other Machines (on the Parallel DSE menu). The 
DSE uses multiple client computers to compile points in the specified exploration 
space. 

Parallel DSE functions in one of the following modes:

■ Use LSF Resources—The DSE uses the PlatformLSF grid computing technology 
to distribute exploration space points to a computing network.

■ Use QSlave—This function uses a Quartus II master process. The DSE acts as a 
master and distributes exploration space points to client computers. 

Table 12–2. DSE Configuration File Location

OS File Location (default) Comment

Windows %APPDATA%/Altera/dse.conf If the variable %APPDATA% is not defined, the 
configuration file is saved to 
/.altera.quartus/dse.conf

UNIX ~/.altera.quartus/dse.conf
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